Access 2016 - Module 2: Building and Using Queries

1. A query allows the selection of a subset of fields and records from one or more tables, then presents the selected data as a single datasheet.
   a. True
   b. False
   ANSWER: True
   POINTS: 1
   REFERENCES: Access 28
   Use the Query Wizard
   QUESTION TYPE: True / False
   HAS VARIABLES: False
   LEARNING OBJECTIVES: ENHA.FRIE.16.022 - Describe the purpose for a query
   DATE CREATED: 2/26/2016 8:14 PM
   DATE MODIFIED: 4/14/2016 12:43 PM

2. You enter and edit data in a query datasheet in the same way you do in a table datasheet.
   a. True
   b. False
   ANSWER: True
   POINTS: 1
   REFERENCES: Access 28
   Use the Query Wizard
   QUESTION TYPE: True / False
   HAS VARIABLES: False
   LEARNING OBJECTIVES: ENHA.FRIE.16.022 - Describe the purpose for a query
   DATE CREATED: 2/26/2016 8:14 PM
   DATE MODIFIED: 4/10/2016 9:20 AM

3. In Access, the Save As command allows you to save either the entire database or the current object with a new name.
   a. True
   b. False
   ANSWER: True
   POINTS: 1
   REFERENCES: Access 32
   Use Query Design View
   QUESTION TYPE: True / False
   HAS VARIABLES: False
   DATE CREATED: 4/10/2016 9:18 AM
   DATE MODIFIED: 4/10/2016 9:20 AM

4. Query criteria are not case sensitive.
   a. True
   b. False
   ANSWER: True
5. To delete records from a query datasheet, click the record selector button to the left of the record, click the Home tab, click the Delete button in the Records group, and click Yes.
   a. True
   b. False
   ANSWER: True
   POINTS: 1
   REFERENCES: Access 30
   Use Query Design View
   QUESTION TYPE: True / False
   HAS VARIABLES: False
   DATE CREATED: 4/9/2016 3:42 PM
   DATE MODIFIED: 4/9/2016 3:43 PM

6. To add, delete, or change fields in a query, you use Query Design View.
   a. True
   b. False
   ANSWER: True
   POINTS: 1
   REFERENCES: Access 32
   Use Query Design View
   QUESTION TYPE: True / False
   HAS VARIABLES: False
   LEARNING OBJECTIVES: ENHA.FRIE.16.024 - Work in Query Design View
   DATE CREATED: 2/26/2016 8:14 PM
   DATE MODIFIED: 2/26/2016 8:14 PM

7. Deleting a field from a query also deletes it from the underlying table.
   a. True
   b. False
   ANSWER: False
   POINTS: 1
   REFERENCES: Access 34
   Sort and Find Data
   QUESTION TYPE: True / False
   LEARNING OBJECTIVES: ENHA.FRIE.16.023 - Delete records in a query
   DATE CREATED: 2/26/2016 8:14 PM
   DATE MODIFIED: 4/10/2016 8:52 AM
Access 2016 - Module 2: Building and Using Queries

**LEARNING OBJECTIVES:** ENHA.FRIE.16.025 - Find and replace data in a query

**DATE CREATED:** 2/26/2016 8:14 PM

**DATE MODIFIED:** 2/26/2016 8:14 PM

8. The asterisk (*) is the wildcard used to represent one and only one character in criteria.
   
   a. True
   
   b. False

   **ANSWER:** False

   **POINTS:** 1

   **REFERENCES:** Access 36
   Filter Data

   **QUESTION TYPE:** True / False

   **LEARNING OBJECTIVES:** ENHA.FRIE.16.026 - Use wildcards in criteria

   **DATE CREATED:** 2/26/2016 8:14 PM

   **DATE MODIFIED:** 2/26/2016 8:14 PM

9. The question mark (?) is the wildcard character which stands for any single character in criteria.

   a. True
   
   b. False

   **ANSWER:** True

   **POINTS:** 1

   **REFERENCES:** Access 36
   Filter Data

   **QUESTION TYPE:** True / False

   **LEARNING OBJECTIVES:** ENHA.FRIE.16.026 - Use wildcards in criteria

   **DATE CREATED:** 2/26/2016 8:14 PM

   **DATE MODIFIED:** 2/26/2016 8:14 PM

10. The easiest way to filter the records for an exact match is to use the Filter By Form feature.

    a. True
    
    b. False

    **ANSWER:** False

    **POINTS:** 1

    **REFERENCES:** Access 36
    Filter Data

    **QUESTION TYPE:** True / False

    **LEARNING OBJECTIVES:** ENHA.FRIE.16.027 - Apply and remove filters in a query

    **DATE CREATED:** 2/26/2016 8:14 PM

    **DATE MODIFIED:** 2/26/2016 8:14 PM
Access 2016 - Module 2: Building and Using Queries

11. To filter for comparative data, use the Filter By Selection feature.
   a. True
   b. False
   
   **ANSWER:** False
   **POINTS:** 1
   **REFERENCES:** Access 36
                   Filter Data
   **QUESTION TYPE:** True / False
   **HAS VARIABLES:** False
   **LEARNING OBJECTIVES:** ENHA.FRIE.16.027 - Apply and remove filters in a query
   **DATE CREATED:** 2/26/2016 8:14 PM
   **DATE MODIFIED:** 2/26/2016 8:14 PM

12. Filters are used to select a subset of records in a datasheet.
    a. True
    b. False
    
    **ANSWER:** True
    **POINTS:** 1
    **REFERENCES:** Access 36
                    Filter Data
    **QUESTION TYPE:** True / False
    **HAS VARIABLES:** False
    **LEARNING OBJECTIVES:** ENHA.FRIE.16.027 - Apply and remove filters in a query
    **DATE CREATED:** 2/26/2016 8:14 PM
    **DATE MODIFIED:** 2/26/2016 8:14 PM

13. A filter can be used to create calculated fields.
    a. True
    b. False
    
    **ANSWER:** False
    **POINTS:** 1
    **REFERENCES:** Access 37
                    Filter Data
    **QUESTION TYPE:** True / False
    **HAS VARIABLES:** False
    **LEARNING OBJECTIVES:** ENHA.FRIE.16.027 - Apply and remove filters in a query
    **DATE CREATED:** 2/26/2016 8:14 PM
    **DATE MODIFIED:** 2/26/2016 8:14 PM

14. A query can be used to create calculated fields.
    a. True
    b. False
    
    **ANSWER:** True
Access 2016 - Module 2: Building and Using Queries

15. By copying a query before starting to make modifications to it, you can avoid changing the original query by mistake.
   a. True
   b. False
   ANSWER: True

16. Enter OR criteria on different Criteria rows in the query design grid.
   a. True
   b. False
   ANSWER: True

17. SQL stands for ____.
   a. Structured Query Lingo  
   b. Standard Query Lingo  
   c. Standard Query Language  
   d. Structured Query Language
   ANSWER: d
18. A query datasheet is sometimes called a ____ of the data.
   a. logical view    b. duplicate copy
   c. table simulator  d. warehouse

   ANSWER:  a
   POINTS:   1
   REFERENCES: Access 28
   Use the Query Wizard

19. In large datasheets, you may want to ____ certain fields so that they remain on the screen at all times.
   a. fix    b. post
   c. freeze  d. view

   ANSWER:  c
   POINTS:   1
   REFERENCES: Access 31
   Work with Data in a Query

20. You use Query Design View to add ____ to limit the number of records shown in the resulting datasheet.
   a. criteria    b. posts
   c. versioning  d. indices

   ANSWER:  a
   POINTS:   1
   REFERENCES: Access 32
   Use Query Design View
Access 2016 - Module 2: Building and Using Queries

21. Query Design View presents the fields you can use for a query in small windows called field ____.
   a. glossaries       b. lists
   c. links            d. catalogs

   ANSWER:   b
   POINTS:    1

22. Access saves ____ automatically as you move from record to record.
    a. data       b. queries
    c. tables     d. all of the above

   ANSWER:   a
   POINTS:    1

23. Use the ____ command to save the current object with a new name.
    a.Datasheet  b. View
    c. Save As   d. Save

   ANSWER:   c
   POINTS:    1

24. A join line is also called a(n) ____ line.
    a. query      b. link
    c. connection d. objectivity

   ANSWER:   b
Access 2016 - Module 2: Building and Using Queries

25. To move a field in the query design grid, click its ____, and then drag it left or right.
   a. field selector  b. field key  
   c. field string  d. field tag

   ANSWER: a

26. When you double-click a field in a field list in Query Design View, it is ____.
   a. deleted from the query  
   b. added to the next available position in the query design grid  
   c. used as the first sort order  
   d. set as the primary key field

   ANSWER: b

27. A(n) ____ is a temporary view of the data that is removed when you close the datasheet.
   a. filter  b. query  
   c. grid  d. sort

   ANSWER: a
28. The wildcard character that stands for any group of characters is the ____.
   a. period (.)   b. semicolon (;)
   c. asterisk (*)   d. plus sign (+)
   **ANSWER:** c
   **POINTS:** 1
   **REFERENCES:** Access 36

29. To sort records based on the selected field in the order Z to A, use the _____ button.
   a. Down   b. Descending
   c. Z to A   d. Reverse Sort
   **ANSWER:** b
   **POINTS:** 1
   **REFERENCES:** Access 35

30. The wildcard character that stands for any single character is the ____.
   a. ampersand (&)   b. question mark (?)
   c. exclamation mark (!)   d. caret (^)
   **ANSWER:** b
   **POINTS:** 1
Access 2016 - Module 2: Building and Using Queries

DATE MODIFIED: 2/26/2016 8:14 PM

31. A(n) ____ is a saved object within the datasheet.
   a. query       b. filter
   c. find        d. union

   ANSWER: a
   POINTS: 1
   REFERENCES: Access 36
               Filter Data
   QUESTION TYPE: Multiple Choice
   HAS VARIABLES: False
   LEARNING OBJECTIVES: ENHA.FRIE.16.027 - Apply and remove filters in a query
   DATE CREATED: 2/26/2016 8:14 PM
   DATE MODIFIED: 2/26/2016 8:14 PM

32. The ____ button provides a list of values in the selected field that can be used to customize a filter.
   a. Values       b. Selection
   c. Filter       d. Advanced

   ANSWER: c
   POINTS: 1
   REFERENCES: Access 37
               Filter Data
   QUESTION TYPE: Multiple Choice
   HAS VARIABLES: False
   LEARNING OBJECTIVES: ENHA.FRIE.16.027 - Apply and remove filters in a query
   DATE CREATED: 2/26/2016 8:14 PM
   DATE MODIFIED: 2/26/2016 8:14 PM

33. The ____ button filters records that equal, do not equal, or are otherwise compared with the current value.
   a. Comparative   b. Selection
   c. Comparison    d. Advanced

   ANSWER: b
   POINTS: 1
   REFERENCES: Access 37
               Filter Data
   QUESTION TYPE: Multiple Choice
   HAS VARIABLES: False
   LEARNING OBJECTIVES: ENHA.FRIE.16.027 - Apply and remove filters in a query
   DATE CREATED: 2/26/2016 8:14 PM
   DATE MODIFIED: 2/26/2016 8:14 PM

34. Criteria ____ is the term for rules by which criteria must be entered in a query.
   a. Syntax       b. Formatting
35. ____ are tests or limiting conditions you set to determine which records will be selected in a filter or query.
   a. Criteria  b. Filters  
   c. Queries  d. none of the above
   
   **ANSWER:** a  
   **POINTS:** 1 
   **REFERENCES:** Access 38
   **QUESTION TYPE:** Multiple Choice 
   **LEARNING OBJECTIVES:** ENHA.FRIE.16.033 - Define criteria syntax 
   **DATE CREATED:** 2/26/2016 8:14 PM 
   **DATE MODIFIED:** 2/26/2016 8:14 PM 

36. To find all records where there is any entry in the field, even if the entry is 0, which criteria should you use?
   a. <> 0  b. Is Not Null  
   c. *=*  d. *<>*
   
   **ANSWER:** b  
   **POINTS:** 1 
   **REFERENCES:** Access 39
   **QUESTION TYPE:** Multiple Choice 
   **LEARNING OBJECTIVES:** ENHA.FRIE.16.035 - Use comparison operators with criteria 
   **DATE CREATED:** 2/26/2016 8:14 PM 
   **DATE MODIFIED:** 2/26/2016 8:14 PM 

37. ____ will find all records where there is any entry in the field, even if the entry is 0.
   a. Like  b. Is Null  
   c. And  d. Is Not Null
   
   **ANSWER:** d  
   **POINTS:** 1 
   **REFERENCES:** Access 39
Access 2016 - Module 2: Building and Using Queries

38. Which of the following comparison operators means "not equal to"?
   a. +=
   b. =/= (not equal to)
   c. <<<>
   d. >

   **ANSWER:** d
   **POINTS:** 1

39. To find numbers greater than or equal to 500, use which comparison operator?
   a. <>
   b. <=
   c. >>
   d. >=

   **ANSWER:** d
   **POINTS:** 1

40. Which of the following comparison operators means "greater than"?
   a. >
   b. >=
   c. <
   d. <=

   **ANSWER:** a
   **POINTS:** 1
41. Which of the following comparison operators means "less than or equal to"?
   a. >     b. >=
   c. <     d. <=
   **ANSWER:** d
   **POINTS:** 1
   **REFERENCES:** Access 39
   Apply AND Criteria

**QUESTION TYPE:** Multiple Choice

42. A(n) ________________ answers a question about the information in the database.
   **ANSWER:** query
   **POINTS:** 1
   **REFERENCES:** Access 28
   Use the Query Wizard

**QUESTION TYPE:** Completion

43. One way to create a new query is with the ________________, which prompts you for the information it needs to create a new query.
   **ANSWER:** Simple Query Wizard
   **POINTS:** 1
   **REFERENCES:** Access 28
   Use the Query Wizard

**QUESTION TYPE:** Completion

44. In Query Design View, the query design ________________ shows you the field names, sort orders, and criteria used with a query.
   **ANSWER:** grid
   **POINTS:** 1
   **REFERENCES:** Access 32
Use Query Design View

**QUESTION TYPE:** Completion  
**HAS VARIABLES:** False  
**LEARNING OBJECTIVES:** ENHA.FRIE.16.024 - Work in Query Design View

**DATE CREATED:** 2/26/2016 8:14 PM  
**DATE MODIFIED:** 2/26/2016 8:14 PM

45. ________________ are limiting conditions you set in the query design grid.

**ANSWER:** Criteria  
**POINTS:** 1  
**REFERENCES:** Access 32  
Use Query Design View

**QUESTION TYPE:** Completion  
**HAS VARIABLES:** False  
**LEARNING OBJECTIVES:** ENHA.FRIE.16.031 - Add criteria to a query

**DATE CREATED:** 2/26/2016 8:14 PM  
**DATE MODIFIED:** 2/26/2016 8:14 PM

46. To add a table’s field list to the upper pane of Query Design View, click the ________________ Table button on the Design tab.

**ANSWER:** Show  
**POINTS:** 1  
**REFERENCES:** Access 33  
Use Query Design View

**QUESTION TYPE:** Completion  
**HAS VARIABLES:** False  
**LEARNING OBJECTIVES:** ENHA.FRIE.16.024 - Work in Query Design View

**DATE CREATED:** 2/26/2016 8:14 PM  
**DATE MODIFIED:** 2/26/2016 8:14 PM

47. To move fields in the query grid, drag the field ________________.

**ANSWER:** selector  
**POINTS:** 1  
**REFERENCES:** Access 34  
Sort and Find Data

**QUESTION TYPE:** Completion  
**HAS VARIABLES:** False  
**LEARNING OBJECTIVES:** ENHA.FRIE.16.032 - Apply sort orders to a query

**DATE CREATED:** 2/26/2016 8:14 PM  
**DATE MODIFIED:** 2/26/2016 8:14 PM

48. Filter By ________________ is a fast and easy way to filter records for an exact match.

**ANSWER:** Selection  
**POINTS:** 1
Access 2016 - Module 2: Building and Using Queries

49. ____________________ a table or query datasheet temporarily displays only those records that match given criteria.

**ANSWER:** Filtering

**POINTS:** 1

50. To search for a pattern, you can use a(n) ____________________ character, a symbol you can use as substitute for characters to find information that matches your find criteria.

**ANSWER:** wildcard

**POINTS:** 1

51. The ____________________ button provides filter features such as Filter By Form, and Clear All Filters.

**ANSWER:** Advanced

**POINTS:** 1

52. Is ____________________ criteria will find all records where no entry has been made in the field.

**ANSWER:** Null

**POINTS:** 1
53. Discuss adding or deleting a table in a query.

**ANSWER:** You might want to add a table’s field list to the upper pane of Query Design View to select fields from that table for the query. To add a new table to Query Design View, drag it from the Navigation Pane to Query Design View, or click the Show Table button on the Design tab, then add the desired table(s). To delete an unneeded table from Query Design View, click its title bar, then press [Delete].

**POINTS:** 1

54. Compare the capabilities of queries and filters.

**ANSWER:**
- Queries are saved as objects in the database. Filters are not.
- Both can be used to select a subset of records in a datasheet.
- Only queries are used to select a subset of fields in a datasheet.
- The resulting datasheet from both filters and queries can be used to enter and edit data.
- The resulting datasheet from both filters and queries can be used to sort, filter, and find records.
- Queries but not filters are commonly used as the source of data for a form or report.
- Queries but not filters can be used to create calculations across records.
- Queries but not filters can be used to create calculated fields.

**POINTS:** 1
Access 2016 - Module 2: Building and Using Queries

ANSWER: AND: All criteria must be true in order for the record to be selected for a datasheet. The criteria are entered on the same row of the query grid.
OR: Any single criterion must be true in order for the record to be selected. The criteria are entered on different rows of the query grid.

POINTS: 1

REFERENCES:
Access 38
Access 40
Apply AND Criteria
Apply OR Criteria

QUESTION TYPE: Essay

LEARNING OBJECTIVES:
ENHA.FRIE.16.037 - Enter AND criteria in a query, Enter OR criteria in a query

TOPICS: Critical Thinking

DATE CREATED: 2/26/2016 8:14 PM
DATE MODIFIED: 2/26/2016 8:14 PM

56. You can enter, edit, and navigate data in a query datasheet just like a(n) report datasheet. ________________

ANSWER: False - table

POINTS: 1

REFERENCES:
Access 28
Use the Query Wizard

QUESTION TYPE: Modified True / False

LEARNING OBJECTIVES:
ENHA.FRIE.16.022 - Describe the purpose for a query

DATE CREATED: 2/26/2016 8:14 PM
DATE MODIFIED: 2/26/2016 8:14 PM

57. SQL is the acronym for “Simple Query Language.” ________________

ANSWER: False - Structured Query Language

POINTS: 1

REFERENCES:
Access 28
Use the Query Wizard

QUESTION TYPE: Modified True / False

LEARNING OBJECTIVES:
ENHA.FRIE.16.022 - Describe the purpose for a query

DATE CREATED: 2/26/2016 8:14 PM
DATE MODIFIED: 2/26/2016 8:14 PM

58. The record selector button is to the right of a record in a datasheet. ________________

ANSWER: False - left

POINTS: 1

REFERENCES:
Access 30
Work with Data in a Query
59. In Query Design View, record selectors are thin gray bars above the field names in the query grid.

**QUESTION TYPE:** Modified True / False

**HAS VARIABLES:** False

**LEARNING OBJECTIVES:** ENHA.FRIE.16.030 - Edit records in a query

**DATE CREATED:** 2/26/2016 8:14 PM

**DATE MODIFIED:** 2/26/2016 8:14 PM

**ANSWER:** False - field

**POINTS:** 1

**REFERENCES:** Access 34

60. Quotation marks are automatically added to criteria for fields with a Date/Time data type.

**QUESTION TYPE:** Modified True / False

**HAS VARIABLES:** False

**LEARNING OBJECTIVES:** ENHA.FRIE.16.025 - Find and replace data in a query

**DATE CREATED:** 2/26/2016 8:14 PM

**DATE MODIFIED:** 2/26/2016 8:14 PM

**ANSWER:** False - Short Text, short text

**POINTS:** 1

**REFERENCES:** Access 33

61. If, for example, a find-and-replace effort does not work correctly, click the Undo button to cancel the changes.

**QUESTION TYPE:** Modified True / False

**HAS VARIABLES:** False

**DATE CREATED:** 4/10/2016 8:55 AM

**DATE MODIFIED:** 4/10/2016 8:57 AM

**ANSWER:** True

**POINTS:** 1

**REFERENCES:** Access 34

62. As you add rows of OR criteria to the query design grid, you decrease the number of records selected for the resulting datasheet.

**QUESTION TYPE:** Modified True / False

**HAS VARIABLES:** False

**LEARNING OBJECTIVES:** ENHA.FRIE.16.038 - Undo edits in a query

**DATE CREATED:** 2/26/2016 8:14 PM

**DATE MODIFIED:** 2/26/2016 8:14 PM

**ANSWER:** False - increase

**POINTS:** 1
63. To make a page wider than it is tall, use landscape orientation. __________________________

**ANSWER:** True

**POINTS:** 1

**REFERENCES:** Access 42
Format a Datasheet

**QUESTION TYPE:** Modified True / False

**HAS VARIABLES:** False

**LEARNING OBJECTIVES:** ENHA.FRIE.16.039 - Change page orientation

**DATE CREATED:** 2/26/2016 8:14 PM
**DATE MODIFIED:** 2/26/2016 8:14 PM

64. By default, the printout of a datasheet contains the object name and current date in the footer. __________________________

**ANSWER:** False - header

**POINTS:** 1

**REFERENCES:** Access 42
Format a Datasheet

**QUESTION TYPE:** Modified True / False

**HAS VARIABLES:** False

**LEARNING OBJECTIVES:** ENHA.FRIE.16.040 - Zoom in print preview

**DATE CREATED:** 2/26/2016 8:14 PM
**DATE MODIFIED:** 2/26/2016 8:14 PM

**Critical Thinking Questions**

**Case 2-1**

Daniel Arno owns a lawn and landscape business with many customers. Occasionally, he wants to filter the data about his customers in various ways.

65. Daniel uses a one-character code to indicate which day of the week certain customers of his have their lawns cut. Which of the following wildcard characters could he use to search for a single character (e.g., F for Friday)?

a. *  
   b. &  
   c. ?  
   d. %

**ANSWER:** C

**POINTS:** 1

**REFERENCES:** Access 36
Filter Data

**QUESTION TYPE:** Subjective Short Answer
66. Daniel wants to make even more use of wildcard characters. Which operator is he most apt to use in these searches?
   a. Find    c. Search
   b. Like    d. Near
   ANSWER: B
   POINTS: 1
   REFERENCES: Access 36
   QUESTION TYPE: Subjective Short Answer

67. Daniel lives in Oxford and he would like to find all customers who do not live in Oxford. Which comparison operator should he use?
   a. =    b. !==
   c. <>    d. <=>
   ANSWER: c
   POINTS: 1
   REFERENCES: Access 39
   QUESTION TYPE: Multiple Choice

Match each term with the statement that best describes it.
   a. Is Null
   b. wildcard
   c. sorting
   d. query
   e. datasheet
   f. filter
Access 2016 - Module 2: Building and Using Queries

68. Creates a datasheet of selected fields and records from one or more tables

**ANSWER:** d  
**POINTS:** 1

69. The lower pane in Query Design View

**ANSWER:** h  
**POINTS:** 1

70. Limiting conditions used to narrow the number of records on a datasheet

**ANSWER:** g  
**POINTS:** 1

71. Putting records in ascending or descending order based on a field’s values

**ANSWER:** c  
**POINTS:** 1

72. Used to search for a pattern

**ANSWER:** b  
**POINTS:** 1

73. Creates a temporary subset of records
Access 2016 - Module 2: Building and Using Queries

**ANSWER:** f  
**POINTS:** 1

74. Criterion that finds all records where no entry has been made in the field  
**ANSWER:** a  
**POINTS:** 1

75. Allows you to apply some basic formatting modifications such as changing the font size, font face, colors, and gridlines  
**ANSWER:** e  
**POINTS:** 1